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What is ApplinX?

ApplinX is a server-based technology that provides web-based applications an efficient, robust
and easy way to access and integrate core system applications' data and transactions, without
changing the core systems.

ApplinX exposes core systems and encapsulates them into standard programmatic components
of the new selected environment (web services, .NET, J2EE, XML). These components can then be
used as advanced building blocks in any modern platform - for new applications or existing ones
(e.g. CRM applications). This way, core back-office systems can be integrated into new strategic
IT platforms, and the workflow can be re-engineered to suit a more streamlined and efficient task-
oriented and role-based approach.
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SOA Enablement

SOA enablement allows reuse of functionality of the core systems, leveraging the operational
qualities of the systems' transaction platform to new IT projects. This is accomplished by exposing
the core systems' functionality and data as web services - either at the screen or transaction level
- and integrating with any other environments that invoke web services. It also enables the core
systems to become active equal peer participants in an SOA world.

Refer to Installing ApplinX Demo Applications. Also refer to the self-training material available
on the Software AG Empower website.

Refer to SOA Enablement in the ApplinX Solutions documentation for further details as how to use
this solution.
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Web Enablement

Pure HTML Emulation

ApplinX HTML emulation is an out of the box thin client HTML emulation, available in the .NET
and J2EE environments. The screenshot belowdisplays a host screen inApplinXHTMLemulation
in the browser.

ApplinX is able to turn an existing terminal emulation instantly into a web browser terminal
emulation, providing host key and print support and maintaining existing color schemes. This
does not require any training for end users and can easily replace locally installed terminal emu-
lation software with the thin-client web browser.

Refer to Installing ApplinX Demo Applications. Also refer to the self-training material available
on the Software AG Empower website.

Refer toWeb Enablement - Pure HTMLEmulation in theApplinX Solutionsdocumentation for further
details as how to use this solution.
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Instant Web Application

The instantweb application allowsmodernization of core system applications intomodern looking
web applications with (little or) no coding. Simple web configurations can improve the general
"Look & Feel" of the application: designing a template with top and side images and a "company
logo" (Inventory System), modifying the style sheet using different fonts, colors, etc. End users
get the information quicker and with improved visibility. Also new users can be trained more
easily (web-like usage).

Using Screen Groups, the same design can be globally applied to multiple screens. Using Trans-
formations, host patterns can be converted to web components. Such transformations include:
formatting the screen's header area, formatting the message line, formatting titles and borders,
converting input fields into GUI elements (combo boxes, radio buttons, check boxes), adding a
calendar component to date input fields, formatting the host function keys into hyperlinks, buttons
or images and removing unnecessary characters.

Refer to Installing ApplinX Demo Applications. Also refer to the self-training material available
on the Software AG Empower website.

Refer toWeb Enablement - InstantWeb Application in theApplinX Solutionsdocumentation for further
details as how to use this solution.
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Composite Web Application

Using the composite web application it is possible to fully customize and extend your web applic-
ations using your Java or .NETdevelopment environment. The compositeweb application enables
aggregating information from many core systems into one web page. It is possible to integrate
legacy assets on various levels (screen, transaction, data), support various web environments
making use of the ApplinX Base Objects (API) and customizing web frameworks.

Refer to Installing ApplinX Demo Applications. Also refer to the self-training material available
on the Software AG Empower website.

Refer toWeb Enablement - Composite Web Application in the ApplinX Solutions documentation for
further details as how to use this solution.
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Server

■ 2 x 3 GHz Intel(R) Xenon(TM) processors (for 500 concurrent users).
■ 2GB free disk space.
■ RAM: ApplinX Server requires 200 MB. Each application requires additional minimum 40 MB
(depending on the application repository size). Host sessions require 1MB per session.

■ Network card.

ApplinX Development Workstation

■ 2GB free disk space (server and development tools).
■ RAM: minimum 4GB.
■ Network card.

Network

ApplinX supports working with IPv6 as well as IPv4 when working with ApplinX components
that use IP addresses.
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Operating Systems and Supported Platforms

For details regarding supported platforms, refer to theRelease Notes. For themost updated inform-
ation refer to the Software AG Empower website at https://empower.softwareag.com.

ApplinX server is Java-based and can run on a Java Virtual Machine 1.7. ApplinX can run inde-
pendently as an independent Java process (this is the default Windows/UNIX installation), or as
a J2EE application under one of the following application servers:

■ Apache Tomcat 5.5/6.0/7.0
■ IBMWebSphere 8.5
■ WebLogic 10.3/11g
■ JBoss 5.0 (Note that it is not possible to deploy an ApplinX server and a JSP web application in
the same war file on JBoss 5.0.)

When running ApplinX as a J2EE application, the ApplinX server needs to be deployed with the
Deployment Manager for J2EE (refer toDeploying with ApplinX in the Designing and Developing an
Application documentation. It is possible to run ApplinX as a standalone server.

ApplinX Repository

ApplinX uses an internal database as a repository, based on the H2 database. External databases
used as repository are no longer supported and will be migrated to the internal DB configuration.
If you are using the JDBC/ODBC bridge, you will need to migrate manually. SeeMigration of
ApplinX Applications with External Database.

ApplinX Web Application for JSP

Developer's station:

■ JDK 1.7
■ Apache Tomcat 5.5/6.0/7.0
■ JSP IDE - it is recommended to use Software AG Designer 9 (based on Eclipse 4.2)

Server:

■ JDK 1.7
■ One of the following application servers:
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■ Apache Tomcat 5.5/6.0/7.0
■ IBMWebSphere 8.5
■ WebLogic 10.3/11g
■ JBoss 5.0

ApplinX .NET Web Application

Developer's station:

■ Microsoft IIS 5.1/6.0/7.5/8.0
■ Visual Studio 2008/2010
■ Microsoft Visual J# .NET Version 2.0 Redistributable Package - Second edition (when using VS
2008/2010)

Server:

■ Microsoft IIS 5.1/6.0/7.5/8.0
■ Microsoft .NET Framework Version 2.0/3.0/3.5/4.0 Redistributable Package
■ Microsoft Visual J# .NET Version 2.0 Redistributable Package - Second edition

Note: When creating an ApplinX .NET web application, view state is turned off by default
(web.config file). If you want to use Net web controls in generated pages, ensure that you
activate this option. Refer to the Microsoft ASP.NET documentation for further details.

Supported Browsers

■ Microsoft Internet Explorer 7, 8, 9, 10, 11

Note: The web integration solution requires recording the browser activity in Internet
Explorer 7, 8 or 9.

■ Mozilla Firefox: latest version provided by vendor when this version of ApplinX was released
■ Google Chrome: latest version provided by vendor when this version of ApplinX was released
■ Safari: latest version provided by vendor when this version of ApplinX was released
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4 License Key Concept

Note: During the installation process, the a check is performed that the license is of the same
version as the installed ApplinX server. The license key format from version 9.6 and earlier
is no longer supported. If you are logged on to SoftwareAG's Empower site, you can request
a new license key from Software AG Logistic Service Center (LSC).

About ApplinX Licenses

ApplinX can be purchased with one of the following types of licenses (it is possible to purchase
more than one type of license):

■ SOA license: Used for SOA enablement, including host transactions (RPC connections) and
direct database access, and for web page integration solutions.

■ Web enablement license: Used for HTML emulation, instant web application and for composite
web application. Printer connections are also counted as web enablement connections.

■ BPD license: Used for the Screen Process Extractor.

The ApplinX license is purchased for a number of users for each type of license. For example, you
can purchase a license for 100 SOA users, and another license file for 50 web enablement users.
When connecting to a session, the number of opened connections is compared with the number
of users defined in the license file. The number of possible users must be equal to or greater than
the number of opened connections.When trying to connectwith an additional user, youwill receive
the following error message: Cannot connect session. The server has reached the full
capacity of concurrent users.

License keys from version 9.6 and earlier are no longer supported. The following user messages
appears when the server starts if in the license directory there is an old license: License key
format from version 9.6 and earlier is no longer supported. You can request a new
license key from Software AG Logistic Service Center (LSC). STOPPING SERVER...

Notes:
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1. When working with a Connection Pool entity, connections will be related to a specific license
type only once they are in use within a specific solution (SOA or web enablement).

2. A session used by a developer within the Designer is not counted as a connection.

3. Once the expiration date defined in a license file is reached, the connections count defined in
the file is dropped from the accumulated connection count (per type).

Support of SOA and Web Features

During the installation process, only one of the licenses is provided. Copy the second to theApplinX
license directory manually. It will be loaded when the server starts.

Updating Your License

If you wish to change the license key after the installation, you need to locate the license file
(<Software AG Installation>\common\conf) and replace the old license with the new one. Restart
ApplinX server and the Designer.

Getting Started14
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5 Installation

ApplinX is installed with the webMethods Installer. Please refer to the webMethods Installer
documentation, which you can find at http://documentation.softwareag.com/.
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Updating a Service Pack (from ApplinX Version 9.7 and above)

The upgrade process is similar to the installation process. Please refer to the webMethods Installer
documentation, which you can find at http://documentation.softwareag.com/. When selecting
the installation directory, ensure not to select the directory where ApplinX is currently installed
(the default path is C:\SoftwareAG).

In the panel including the ApplinX specific parameters, browse and select the ApplinX license
file.

Post-update Results

■ When opening the Software AG Designer, the default workspace will point to a new location.
It is possible to select and use the workspace location from the previous version, and in this way
preserve your preferences (such as ApplinX server connection list and ApplinX (Eclipse) pref-
erences (Windows > Preferences > Software AG > ApplinX)) from the previous version. If you
use the new workspace location, check that the preferences suit your needs.

■ From version 8.2, the batch and shell commands used to start and stop the server, and to start
the Administrator are located in the <ApplinX installation>/bin folder.

Post-update Tasks

■ When using ApplinX web applications (JSP or .NET): Upgrade the web application using the
ApplinX Web Application Manager in the Designer (refer to Framework Management in theWeb
Application Development documentation of ApplinX).

■ You may have made changes in your previous ApplinX version, in one of the following files.
Backup copies of these files can be found (unless otherwise stated) in the ApplinX installation
directorywith the .bak suffix. To apply these changes to your current ApplinX version, youmust
copy the changes from within the backup files to the relevant file.
■ GXApplinXService.ini
■ bin/startup.bat
■ bin/startup.sh
■ bin/gxadmin.bat
■ bin/gxadmin.sh
■ config/gxadmin.prp
■ config/gxstartup.prp
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Migrating

ApplinX applications from previous ApplinX versions are able to run on the current ApplinX
version once you have performed a number of migration activities. The migration process has
been tested for migration from ApplinX versions 8.2.2, 9.0.2, 9.5.0 and 9.6.0. Migration can be
performed when installing the new ApplinX server version or via batch files after the new server
has been installed.

The following topics are covered below:

■ Pre-Migration Steps and Prerequisites
■ Migration
■ Migration Results
■ Post-migration Tasks
■ Post-migration Tasks for Entities Created in Versions before 8.0
■ Post-migration Web Application Tasks

Pre-Migration Steps and Prerequisites

■ Back up the repository database.
■ When using ApplinX .NET 1.1 web applications based on Visual Studio 2003, you will require
installing Visual Studio 2008/2010.NET 2.0-4.0 as .NET framework 1.1 is no longer supported.

Migration

Migration can be carried out as follows:

■ Migration of all ApplinX applications when installing ApplinX
■ Migration of all ApplinX applications after installing ApplinX
■ Migration of a specific ApplinX application
■ Migration of ApplinX applications with external database

Migration of all ApplinX applications when installing ApplinX

To migrate ApplinX applications during the installation process: In the screen where you select
the ApplinX parameters, select theMigrate previous ApplinX data check box and specify the
existing installation location.
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Migration of all ApplinX applications after installing ApplinX

To migrate all ApplinX applications after the installation has been completed: Run the <ApplinX
root>\utilities\migrate_ApplinX_server.bat/sh file, enter the installation path of your previous install-
ation, and then enter the new path of the current installation.

For example: migrate_ApplinX_server.bat "c:\ApplinX52" "c:\SoftwareAG\ApplinX"

Getting Started20
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Migration of a specific ApplinX application

To migrate a single ApplinX application from versions previous to 8.0:

1. Export the relevant GXZ file of the application (the GXZ file in older versions (5 and below)
includes both the application and the entities).

2. Convert the GXZfile to aGXARfile (using <ApplinX root>/utilities/convert_gxz_to_gxar.bat). Refer
to Convert Utility Batch File in the Administration documentation.

3. Import theGXARfile intoApplinX 8.x. Refer to Importing anApplication's Configuration or Entities
in the Designing and Developing an Application documentation.

To migrate a single ApplinX application from version 8.x and above:

1. Export the relevant GXAR file of the application (the GXAR file includes both the application
and entities).

2. Import the GXAR to the new version. Refer to Importing an Application's Configuration or Entities
in the Designing and Developing an Application documentation.

Migration of ApplinX applications with external database

For ApplinX applications that use an external database (except JDBC-ODBC), the database type
will be changed automatically to internal database. A message warns that there are applications
containing a JDBC-ODBC database type that will not be migrated. You have two options:

1. ChooseOK to continue with the installation. ApplinX will migrate all applications except for
the JDBC-ODBC types. The names of these applications will be written to a log.

2. Choose Cancel to stop the installation, then modify those applications.

To modify JDBC-ODBC applications

■ Change the repository type to internal DB /gxz in the original ApplinX installation installed
on your computer, and then restart the installation and migration.

Migration Results

The following is the outcome of themigration process and relates tomigrating all ApplinX applic-
ations:

■ The entire old config folder (except for the http.xml file) is copied to the new installation location.
The gxstartup.prp file from this folder is renamed to .bak, and the new gxstartup.prp file (from
the new installation) is used.

■ The new config folder (from the new installation) is renamed to config.bak.
■ The entire host-applications folder is copied except for the demo applications. The demo applica-
tions from the new installation are used.
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■ All database related jar/zip (classes*.zip, classes*.jar, *sql*, *db2*) are copied to the lib folder of the
new installation. Note: any other DB driver should be copied manually to \ApplinX\applinx-
web\WEB-INF\lib.

■ The batch and shell commands used to start and stop the server, and to start the Administrator
are no longer located in the ApplinX installation folder. These files are now located in <ApplinX
installation>/bin folder and are named startup.bat and shutdown.bat accordingly for the server, and
gxadmin for the Administrator.

The start-gxserver.bat/sh and gxadmin.bat/sh files from the previous ApplinX installation are
copied to <ApplinX Installation>\bin and the gxstartup.prp and GXApplinXService.ini files are
copied to <ApplinX Installation>. These files are renamed to *.bak.

Notes:

1. Anymanual changesmade in the previousApplinX versions (such as language, file encoding,
database jar etc.) must be backed up and copied to the new version.

2. Whenmigrating fromAPX 8.0, conf folder (internal Tomcat) is not copied from the old install-
ation. Therefore any manual change made in this folder must be re-done again in the new
conf folder.

Relevant for migrating from ApplinX versions before 8.0:

The following actions occur when the server is started for the first time after themigration process
has been completed:

■ Each application (configured in config/gxconfig.xml), will be created as a separate file and copied
to host-application/<application name>/gxconfig.xml. The original file config/gxconfig.xmlwill hold
from now on only ApplinX server configuration and host definitions which are not in use by
any application.

■ Replay files are copied to host-applications/<application name>/records and new recorded files are
saved in this location.

■ If a file based repository (GXZ orMDB) is configured for the application, the repository is copied
to host-applications/<application name>/db .

A post-migration report is written to the <ApplinX root>/log/gxlog.txt.

Note: If the application name includes space characters, these are replaced by underscores,
as space characters are not supported in versions from 8.0 and above. However, previous
SOAP clients will be able to connect to old addresses which include spaces.
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Post-migration Tasks

■ When opening ApplinX Designer, enter the name of a workspace directory. When upgrading
from ApplinX version 8.0 and above, define a new workspace directory in order to be able to
work with both versions.

Post-migration Tasks for Entities Created in Versions before 8.0

Note: The following entities are still supported in runtime, but cannot be edited or changed,
it is therefore strongly recommended to follow the guidelines below

■ Old Paths and Path Wrappers
■ Path-based Tables
■ Map Paths
■ Namespaces
■ Procedure Groups
■ Tables
■ Procedure Clients

Old Paths and Path Wrappers

Paths and Path Wrappers require a conversion process.

Note: When converting a Path Wrapper, the path which is invoked by the path wrapper is
also converted. When converting a Path which is invoked by a Path Wrapper, the Path
Wrapper is also converted.

To convert

1 Right-click on the Path or Path Wrapper and select Convert. The Conversion wizard is dis-
played. The first screen displays the name of the Path and Path Wrapper that are to be con-
verted.

2 ClickNext.

3 Warning Messages: The conversion process may detect that the Path/Path Wrapper which
you are attempting to convert includes steps which need to be manually tweaked, after the
conversion has been completed, ormay include attributes or settingswhich cannot be conver-
ted. Read the warnings carefully to understand whether you are required to make changes
after completing the conversion.

■ Path warning messages
Warningmessages appearwhen a path detects one of the following issues.Manual changes
may be required for items that are not supported:
■ Path timeout (the conversion process does not support this).

23Getting Started

Upgrading, Migrating and Installing Fixes



■ Exception paths are not handled in the conversion process. Now, there can be only one
Exception path per application, defined in the application properties.

■ "*lastup" field is not supported.
■ <any unexpected screen> is not supported.
■ Input values in "any screen" are not supported. It is recommended to define a Screen
Group for these fields instead of mapping to ANY screen.

■ Inputs are not mapped when the input field is not found in either the source or target
screen.

■ Path Wrapper warning messages
The conversion process does not support collecting attribute data from within a specific
instance of a screen. To preserve this setting, you need to manually define to collect data
from this screen: when you know the specific instance, preserve the links to outputs in the
relevant step and remove links to outputs within irrelevant steps.

■ Retrieving field colors using the Path Wrapper returned colors such as LightBlue and
LightYellow in a single word. After the conversion these colors are returned as two words,
separated with a space (i.e. Light Blue, Light Yellow).

■ It is only possible to convert a PathWrapper that invokes an old Path. PathWrapperswhich
invoke Path Procedures cannot be automatically converted.

■ The Always collect last screen option, if selected, is ignored in the conversion process.

ClickNext.

4 WhenApplinX detects that an entitywith the name of the entity that you are trying to convert,
already exists, you are required to enter a different name. ClickNext.

5 The Summary screen is displayed. Here you can see the entities that are to be converted. Select
whether to open these entities in the Editor once the conversion process is completed.

Path-based Tables

Old Path based tables are still supported in runtime, but cannot be edited or changed. It is recom-
mended to convert the path used by the table.

1. Right-click on the path and select Convert.

2. The table must be represented as a Data Structure array in the path procedure output. In order
to do this, one must first define a Data Structure type (entity) that will represent a single row
in the table. Follow these steps to do this:

a. In the relevant ApplinX screen, add a Table definition of the tabular data. This allows you
to easily create a Data Structure entity and map data to the procedure output.

b. In the relevant step, right-click the screen table and select Create Data Structure.

c. Select the Path Procedure root node and then define an output as an array of the newly created
structure type.
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d. In the mapper, drag the screen table onto the data structure array output. Ensure that all of
the table columns are properly mapped to the arrays attributes.

e. Create a Procedure Group and assign the path procedure to it.

f. Generate a Procedure Client into the web project (refer to Generating a Procedure Client in the
Designing and Developing an Application documentation).

g. In the relevant web page, replace the gx_fillTable code with code that executes and binds
the procedure result to the HTML table (refer to Binding Procedure Outputs to an ApplinX
Framework Based Web Page in theWeb Application Development documentation).

Examples for collecting tables can be found in CompositeDemo (BrowseCustomers1.jsp/aspx) or
SOADemo (CustomerList.jsp/aspx).

Map Paths

All map paths are automatically merged into a single Application Map during the repository
synchronization (refer toApplicationMap in theDesigning and Developing an Application document-
ation). The Map paths are removed and each step in them is assigned to its relevant screen. These
steps appear in the screen editor, in theMap Steps tab.

Note: Advanced usage in the old Map path flow tab or dynamic variables is currently not
supported in the newApplicationMap. Refer toApplicationMap in theDesigning and Devel-
oping an Application documentation for further details.

Namespaces

The Namespace entity is deprecated. It is not possible to create new Namespaces, however, in
procedure groups you can still specify a Namespace. A migrated application that had Data
Structures (Business entity in 5.2 and lower) that were associated with namespaces still refers to
them, but this reference is not displayed and is not editable. Procedure groups display the
namespace name and allow you to edit the name.

Procedure Groups

If you have Procedure Groups in the repository, their SOAP clients are redirected to WS-Stack.
Set each procedure group to automatically be deployed to WS-Stack (in the Procedure Group ed-
itor).

Note: For performance improvements, it is recommended to regenerate all your SOAP clients.
For automatic deployment of the web services to WS-Stack, the application initialization
mode should be set to "Automatic".
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Tables

Sorting functionality in tables is no longer provided.

Procedure Clients

When working with an application which included space characters in the application name, you
are required tomanually change the application name in each of the Procedures Clients, replacing
the space character with an underscore.

Post-migration Web Application Tasks

JSP:

1. Ensure that you have:
■ JDK 1.7
■ A supported web server (refer to ApplinX Web Application for JSP in the section Software
Requirements).

2. It is recommended to import/copy theweb applications from older Eclipse versions to Software
AGDesigner 8.2 (based Eclipse 3.6 technology), as this is the common SoftwareAGdevelopment
tool, usedwith other SoftwareAGproducts such asApplinX, EntireX, CentraSite and Integration
Server.

3. Upgrade the web application using the ApplinX Web Application Manager in the Designer
(refer to Framework Management in theWeb Application Development documentation).

4. Compile the JSP project:
■ With IDE (from Eclipse or any other IDE)
■ Without IDE (make.bat)

Note: Whenworkingwith an applicationwhich included space characters in the application
name, you are required to manually change the application name in the web application
(e.g. inGXBasicWebForm.jsp file, or in the Framework Configuration Editor, in theApplica-
tion name parameter).

.NET:

1. Visual Studio 2003 and .NET 1.1 Users: Visual Studio 2003/.NET 1.1 applications should be
migrated to Visual Studio 2008/2010.NET 2.0-4.0 using Microsoft's Visual Studio automatic
converter.

2. It is recommended to convert from .NET project type "Web Project" to "Web Site" as from the
current version ApplinX generates .NET web pages based on the "Web Site" format and file
structure.
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3. Upgrade the web application using the ApplinX Web Application Manager in the Designer
(refer to Framework Management in theWeb Application Development documentation).

4. Compile (relevant for .NET "Web Projects" type projects):
■ With IDE (from Visual studio)
■ Without IDE (make.bat)

Note: Whenworkingwith an applicationwhich included space characters in the application
name, you are required to manually change the application name in the web application
(e.g. in GXBasicWebForm.cs/GXBasicWebForm.vb file, or in the Framework Configuration
Editor, in the Application name parameter).

Installing a Fix using Scripts

Fixes are available for UNIX and Window on the Software AG Empower website. Follow the in-
structions below when downloading the fix from Empower.

Note that when applying a fix, you must make sure that the installed ApplinX version is of the
same service pack as the fix version, i.e. that the first three digits are the same (e.g. 9.5.1).

To install a fix

1 The fix will install and add all the necessary new files to your existing ApplinX installation.

2 Before starting the fix installation, close ApplinX and Eclipse and stop the ApplinX service.

3 To start the fix installation process, extract the fix zip file to the existing ApplinX directory:
For example: C:\SoftwareAG\ApplinX. A new directory is created: \hotfix-<hot fix version>.

4 To install the fix, just run install-hotfix.bat on Windows platforms, or install-hotfix.sh on UNIX
platforms. OnWindows platforms: Check that the ECLIPSE_PATH parameter is pointing to the
desired Eclipse installation location and that you have removed the rem remark indication.

5 During the fix installation, a backup folder will be created containing the original files from
before the update (backup-for-hotfix-<hot fix version>).

6 After the fix installation, a log is created with a list of all the copied files (install.hotfix.log).

7 Upgrade the web application using the ApplinX Web Application Manager in the Designer
(refer to Framework Management in theWeb Application Development documentation).

Note: It is possible to uninstall the fix. This will revert all updated files to their original state.
To uninstall the fix, just run uninstall-hotfix.bat onWindows platforms, or uninstall-hotfix.sh
on UNIX platforms. After the fix uninstallation, a log is created with a list of all copied files
(uninstall.hotfix.log).

27Getting Started

Upgrading, Migrating and Installing Fixes



28



7 ApplinX Server

The ApplinX server can be started either as a Windows service or using a batch file. ApplinX can
also run under a JavaApplication Server (for further details, refer to the relevant topics inDeploying
with ApplinXwhich is included in the Designing and Developing an Application documentation).

Windows Service:

In the installation process, it is possible to define that ApplinX server runs as a Windows system
service, started and stopped viaStart > Settings >Control Panel >Administrative Tools > Services.
By default, the service is automatically run when starting the computer.

Batch Files:

ApplinX Server can be run using batch command files, located in the <ApplinX installation>/bin
folder:

Starts the ApplinX server.startup.bat

Stops the ApplinX server.shutdown.bat

UNIX Environments:

In the ApplinX installation directory, you can find the following shell scripts:

Starts the ApplinX server.startup.sh

Stops the ApplinX server.shutdown.sh
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Starting the Server Administrator

From the Startmenu, select Software AG > Administration > ApplinX Administration <version
number>.

Alternatively, you can run the Administrator from a remote PC (for example: on a Microsoft
Windows operating system) and connect to the server using TCP/IP.

Logging On

Once you start the ApplinX Administrator, the Logon screen is displayed. When this is the first
time you are logging on, by default, "Administrator" will be displayed in the User name field.
Type the server address (IPv4 and IPv6 address formats are supported) and port. When it is not
the first time you are logging on, the Administrator will automatically try to connect to the last
server it connected to.

Main Screen

The screen consists of four parts:

■ Title bar, menu bar and toolbar.
■ ApplinX Explorer pane.
■ Main view: The main view corresponds to the selected node/entity/session in the ApplinX Ex-
plorer.

■ Status bar: The status bar displays information according to the object selected in themain view.
The status bar may include information such as: the user name, application name, the number
of users connected, indication of file tracing/replaying or the host address.

Operations, features and applications that the logged-in user is not authorized to use will be dis-
abled or are invisible.

■ ApplinX Explorer
■ Toolbar
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■ Menu Bar

ApplinX Explorer

Enables viewing and controlling users' activity, maintaining the server's configuration, viewing
runtime information about connection pools, sessions, server logs, define hosts and design and
configure applications.

The root node.ApplinX

Includes managerial functions.Management

Controls the sessions connected to the server, the server activity and the connection
pools. TheCurrent Activity node is unavailable when the ApplinXAdministrator is not
connected to the server.

Current Activity

Lists the currently connected sessions.Sessions

Provides runtime information regarding the connection pools.Connection Pools

Holds the definitions of the users, their permissions and roles, and the user groups.Security

Lists the server logs.Server Logs
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Toolbar

DescriptionIcon

Disconnect from Server

Connect to Server

Server Information…

Server Log

New Folder

New User

New Group

Delete

Refresh

Up One Level

Menu Bar

File Menu

DescriptionMenu Item

Creates a new user or group.New

Opens the selected item.Open

Deletes the selected item.Delete

Opens the properties of the selected item.Properties

Exits the Administrator.Exit

Edit Menu

DescriptionMenu Item

Selects all entities displayed in the main view.Select All

Selects all entities that were not selected, and deselects entities that were selected.Invert Selection
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ViewMenu

DescriptionMenu Item

Hides/shows the ApplinX Explorer tree area of the screen.ApplinX Explorer

Hides/shows the summary area of the screen.Summary

Displays the server log.Server Log

Refreshes the main view to match the data stored on the server.Refresh

Connection Menu

DescriptionMenu Item

Connects and disconnects the Administrator from the server.Connect/Disconnect

Displays the View Sessionwindow of the selected session.Cancel Session

Tools Menu

DescriptionMenu Item

Displays the Server Information dialog box.Server Info

Displays the User Information dialog box.User Information

Restarts the log.Restart Log
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Starting the ApplinX Designer

From theStartmenu, selectAll Programs > SoftwareAG>Tools > SoftwareAGDesigner <version
number>.

Alternatively, you can run the Designer from a remote PC (for example: on a Microsoft Windows
operating system) and connect to the server using TCP/IP. When running the Designer from a re-
mote PC, some Designer features may not work, for example opening the file system.

The first time you start the Designer, a Welcome page will be displayed. From this page you can
access the ApplinX perspective and the help contents. If you close the Welcome page, and you
would like to display the ApplinX perspective, go toWindow > Open Perspective > Other and
select ApplinX.

If you are not yet familiar with Eclipse, see the Eclipse online help at http://www.eclipse.org/doc-
umentation/, or start the Software AG Designer and then chooseHelp > Help Contents. General
information on Eclipse can then be found underWorkbench User Guide. When working with the
Software AG Designer, the online help also provides help for the currently installed Software AG
products; this can be found under Software AG Designer Guides.

Logging on

Once the Designer is displayed, you will see the available list of servers. Double-click on a server
or select Connect from the right-click context menu. When this is the first time you are logging
on, by default, "Administrator" will be displayed in the User name field. When it is not the first
time you are logging on, ApplinX Designer will automatically try to connect to the last server it
connected to.

You can select to remember the user password in the Login dialog box. Once this is selected, the
Login dialog box is not shown again. To require entering a password and displaying the Login
dialog box, change the Remember passwords check box inWindow > Preferences > Software
AG > ApplinX.

Note: The first time theRemember password check box is selected, an Eclipse Secure Storage
message is displayed. Thismessage offers remembering an internal Eclipse password using
a hint, but this is not applicable to the ApplinX server password, therefore clickNo.
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Adding a New Server Connection

Additional connections to servers can be added. To add an additional server connection, in the
Servermenu, selectAdd ApplinX Server Connection.... The wizard is displayed. Enter the name
of the server, the relevant address (IPv4 and IPv6 address formats are supported) and port. Also
determine whether the connection will be a secured connection.

For further details regarding the server configuration, refer to Configuring the Server in the Admin-
istration documentation.

The Designer Layout

■ ApplinX Related Menu Bar Commands
■ ApplinX Explorer
■ Editor
■ Application Map
■ Properties
■ Console
■ Error Log
■ Status Bar

By default the layout is as displayed below, but as possible in Eclipse, the layout can be changed.
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ApplinX Related Menu Bar Commands

Detailed below are the ApplinX related commands that are included in the menu bar.

File Menu

Creates a new ApplinX application.New > ApplinX Application...

Creates a new ApplinX host.New > ApplinX Host...

Creates a new entity from the list of entities.New > Entity

Creates a new display session or printer session (according to the selected
option).

New > Session

Enables importing ApplinX entities or importing/replacing an ApplinX
application.

Import....

Enables exporting ApplinX entities or application.Export...
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Session Menu

Creates another session with the same definitions as the selected session.Duplicate Session
Definition

Connects to the host using the selected session definitions.Connect

Disconnects the session from the host.Disconnect

Opens the session as an instant web application. The session is displayed by
default in the Editor area of Eclipse. It is possible to display the session in your

Open HTTP Session

system's browser by changing theweb browser definitions in Eclipse (Window
> Preferences > General > Web Browser). This is convenient for checking
transformations. This is only availablewhen you have aweb enablement license.

Entity Menu

Displays the WSDL in the Editor area.ShowWSDL

Copies the WSDL URL to the Clipboard.Copy WSDL URL

Displays anHTMLpreviewof the screen.Useful to preview
transformations that are used in this screen.

Open HTML Preview

Generates a JSP page from the current screen.Generate > JSP Page from Screen…

Generates a JSP page from the current screen group.Generate > JSP Page from Screen Group…

Generates a Procedure Client from a procedure group.Generate > Procedure Client…

Generates a JSP page from a procedure.Generate > JSP Page from Procedure…

Converts a screen to a screen group.Convert > Screen to Screen Group

Converts a screen group to a screen.Convert > Screen Group to Screen

Converts a path to a path procedure.Convert > Path / Path Wrapper to Path
Procedure

Application Menu

Opens the application.Open Application

Closes the application.Close Application

Reloads the repository.Reload Application

Imports into the application a list of predefined
transformations.

Import Predefined Transformations

Opens a wizard which enables importing screen maps.Import Host Screen Maps

Displays the Application Map view.Show Application Map

Opens a wizard which enables to automatically identify
screens.

Automatically Identify Screens/Steps using
Trace Files...

Opens a wizard which enables to extract business activities
from trace files.

Extract Business Process Activities
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Initiates theWeb ApplicationManager wizardwhich enables
creating a web application.

Web Application Manager...

Initiates the Deployment Manager wizard which enables
deploying.

Deployment Manager for J2EE...

Opens the file system and allows viewing the files in the
relevant folder.

Open in File System

Server Menu

Adds an additional server connection.Add ApplinX Server Connection...

Connects to the server.Connect to Server

Disconnects from the server.Disconnect from Server

Reloads the server configuration, i.e. the configuration of all applications
connected to the server.

Reload

Displays a list of the available web services.ShowWeb Services

ApplinX Explorer

The ApplinX Explorer is comprised of the ApplinX Explorer toolbar and the ApplinX Explorer
tree.

ApplinX Explorer Toolbar

Adds a new server connection.

Connects to the selected server.

Disconnects from the selected server.

Enables finding an entity.

Enables creating new entities in the currently selected application.

ApplinX Explorer Tree

Local ApplinX server

Hosts

<Host name>

<Application name>

Session (disconnected)

Session (connected)

Printer Session
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Repository

Screen

Screen Group

Transformation

Connection Pool

Connection Information Set

Procedure Group

Flow Procedure

Path Procedure

Program Procedure

Data Structure

Database Connection

External Web Service

Editor

The various entity editors are displayed in the editor area: Screen, Screen Group, Transformation,
Connection Pool, Connection Information Set, Path Procedure, ProcedureGroup, FlowProcedure,
Program Procedure, Data Structure, Database Connection and External Web Service. This area
also displays the HTML preview of a screen, the list of all relevant web services and a specific
WSDL.

Application Map

The Application Map view displays application screens through which the user has navigated.
Refer to Application Map in the Designing and Developing an Application documentation for further
details.

Properties

This area displays basic details regarding the object selected in the ApplinX Explorer tree. For ex-
ample, when selecting the Server, the Properties area displays a number of parameters such as
the server address, port, state and version. Another example is when selecting the Repository, or
a folder within the repository, the Properties area displays parameters such as the application
name, a detailed list of all the entities, and the number of each type of entity.
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Console

This area displays the console messages.

Error Log

This area displays the error log.

Status Bar

Name of GCT trace file/application name.Online/Offline indication

UNKNOWNwhen the screen has not been identified.Screen name

Row and column, and position in the host.Cursor position

Row and column, and position in the host.Mouse position

Starting position of the currently selected area (in host units).Selection start
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10 Creating a New Application

An application is a project which can contain an internal system within an organization, such as
human resources, billing, customer services etc. In this task, youwill create a newApplinX applic-
ation. Every ApplinX application is connected to a host and has a repository containing all the
ApplinX entities. The steps detailed in this task include the basic steps required to create an applic-
ation. Advanced configuration is explained in Application Configuration Parameters in the Reference
Guide.

To create an ApplinX application

Before creating a new application, ensure that ApplinX server is available and running, and start
the Designer. Log in to the relevant server or add an additional server as required (refer to the
sections Logging on and Adding a New Server Connection.

1 In the ApplinX Explorer, right-click on the ApplinX server and selectNew Application... .

Or:

Select the menu item File > New > Other.... In the resulting window, expand the Software
AG node, then the ApplinX node, select Application, and then clickNext.

The Create a New Applicationwizard is displayed.
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2 Enter a name for the application and a suitable description.

3 Select the initialization mode:

Automatic
Automatically loaded when the server is started.

When first accessed
Loaded when first accessed, in other words, when the code that initializes startup is first
called (default).

4 ClickNext.

Getting Started46

Creating a New Application



Select whether to use an existing host or to create a new host.

Note: SAG_MainFrame is accessible only from within the Software AG network.
Therefore, this host can only be selected when working offline using a trace file.

5 When selecting to define a new host, enter a name for the host and select the relevant type of
host. ClickNext.
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The host connection and conversion parameters are displayed. It is mandatory to enter the
host's name/IP address (IPv4 and IPv6 address formats are supported). Configure the other
parameters as required. Further details of these parameters are available inHost Configuration
Parameters in the Reference Guide.

6 Click Finish. The application is displayed in the ApplinX Explorer. It is possible to further
configure the application properties by right-clicking on the application name and selecting
Properties. Refer to Application Configuration Parameters in the Reference Guide for details re-
garding the advanced configuration properties.

Confirming Connectivity

To confirm connectivity to the host

1 In the ApplinX Explorer, expand the relevant application node.

2 Expand the Sessions node. Right-click onDefault and select Connect. The first host screen
is displayed and the icon of the default session changes to . Navigate between the screens
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to confirm connection and host functionality. If there is a connection problem, check that the
host is working and that the host definitions are correct.

Further information regarding application configuration can be found in Defining Applications in
the Designing and Developing an Application documentation.
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Creating an ApplinXWebApplication for JSP using the Software AGDesigner
(recommended)

The following is based on the released Eclipse version. Additional information can be found on
Eclipse website and WTP (web tool platform) site.

To create a new Dynamic Web project

1 In the Eclipse workspace, select File > New > Project to create a new project.

2 SelectWeb > Dynamic Web Project.

3 ClickNext to create a newwebproject. TheNewDynamicWebProjectdialog box is displayed.

4 Enter a name for the project.
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5 In the Target Runtime field, select the Tomcat installation: clickNew... and select the server
to be used: Either J2EE Preview (recommended) or Tomcat v5.5.

Important: The Restart function in the J2EE Preview server does not work properly. In-
stead of using the Restart function, stop and the start the server. In addition, editing
files only works after stopping and starting the server.

6 ClickNext.
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7 Browse and select the Tomcat installation.

Note: Currently theApplinX internal Tomcat cannot be used to create aweb application
and when selecting to use Tomcat, you are required to install an additional Tomcat 5.5
version.

8 Select a JRE or click Installed JREs… to add a new JRE. The Preferences dialog box is dis-
played.
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9 Define the Runtime Environment (JRE) for the server: JSP server requires a full JDK and not
only the JRE bundle. If you need to add a new JRE, click the Add… button.

55Getting Started

Creating an ApplinX Web Application



10 Assign a name to the new JRE.

11 Enter the JRE home directory (when necessary, click Browse... to locate the file).

12 Add VM arguments when required.

13 ClickOK to return to theNewServer Runtimedialog box. Select the newly created JRE. Click
OK.

14 Click Finish. TheNew Dynamic Web Project dialog box is displayed.

You have completed the configuration of the flexible project, the server (Tomcat) and the JDK.

15 Change the configuration to Custom and clickModify.

Getting Started56

Creating an ApplinX Web Application



Select ApplinX Framework. Ensure that the Dynamic Web Module and Java check boxes
are selected. ClickOK.

16 ClickNext.

17 ClickNext.

18 Select ApplinX installation from which to create the web project and select the application
type.
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19 ClickNext.
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Select the template to use in your application.

20 Click Finish.

You have completed the creation of a standard WAR file (Java Web Archive).

21 Ensure that in the Projectmenu, Build Automatically is selected.

To run the project, right-click on the project's folder in the Project Explorer view and select
Run As > Run on Server….

The first time you run a project you are required to select a default server:

Select the server you configured.

Select the Always use this server when running this project check box. The next time you
run the application, this dialog box will not be displayed. The server you selected will auto-
matically be used.

Click Finish to continue. A browser window will be opened.
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Note: The browser type can be configured underWindows > Preferences > General >
Web Browser. It is recommended to configure it toDefault system web browser.

Using the Javadoc as a reference within the code

When using the Javadoc you will have:

■ Online usage of the Eclipse Javadoc for ApplinX API.
■ Suggested argument names for the ApplinX API, instead of arg0, arg1, etc.

To use Javadoc capabilities when developing your project

1 Right-click on the project node and selectBuild Path >Configure Build Path…. TheProperties
dialog box is displayed.

2 In the Libraries tab, expand the gxframework.jar node, click on Javadoc location and then
click on the Edit… button to determine the location of the Javadoc.

3 You can either enter theURL http://localhost:2380/applinx-help or browse and select the Javadoc
location path <Software AG installation> > ApplinX > Help > API. Then clickOK.

4 ClickOK to close the Properties dialog box.

Creating an ApplinXWeb Application for JSP using JDK and Tomcat (no IDE)

Note: This is not available when working with a SOA license.

To create a new JSP application without any IDE and with JDK

Refer to ApplinX Web Application for JSP in Software Requirements.

1 During the installation process, choose the option ApplinX Framework for JSP.

2 In the ApplinX Explorer, right-click on the relevant application and selectWeb Application
Manager…. TheWeb Application Managerwizard is displayed.
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3 Ensure that Create a newWeb application (for IIS or Tomcat) is selected. ClickNext. The
Create a NewWeb Application screen is displayed.
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4 Ensure that JSP is selected. Select the application type:New application to create a basic
ApplinXweb applicationwith aweb look and feel orEmulation template to create anApplinX
web application with a host look and feel.

5 ClickNext. The Select Template screen is displayed.
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Select a template from the list on the left.

6 ClickNext. The Create a New JSP Web Application screen is displayed.
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Enter a name for the web application. By default this is the name of the ApplinX application
that you selected. Browse and select the folder where Tomcat is installed. Select the location
of the JDK installation.

When you wish to use the ApplinX internal Tomcat, select the corresponding check box.

7 ClickNext. TheWizard Summary screen is displayed.

8 Select whether to launch the browser when the process is completed.

9 Select whether to restart Tomcat. This is only relevant when Tomcat is activated from a batch
file. The Framework Manager does not support restarting Tomcat when Tomcat runs as a
Windows Service (in this case, you need to manually restart Tomcat).

10 Click Finish. Amessagewill be displayed indicatingwhether the process succeeded or failed.

Note: Any change in the Java file requires recompilation of your new application. Changes
in JSP files do not require recompilation. Furthermore, Tomcat requires reloading: http://loc-
alhost:8080/manager/reload?path=/<YOUR_APP_NAME>.
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Creating an ApplinX .NET Web Application using Visual Studio 2008

To create a new ApplinX web application using Visual Studio 2008

1 Install J# 2.0 redistributable package Second edition.

2 Install Microsoft Visual Studio 2008 on your computer (install Visual Studio before installing
ApplinX so that when installing ApplinX, the ApplinX web application templates will be
added to the available Visual Studio NewWeb Sites).

3 Open Visual Studio 2008.

4 In the Filemenu, selectNew and thenWeb Site… to create a new web site. TheNewWeb
Site dialog box is displayed.

5 Select the relevant ApplinX web application type (Visual C# or Visual Basic).

6 Determine whether you would like to upgrade to .NET framework 3.5 or continue working
with .NET framework 2.0 (both options are acceptable).

7 Define that index.aspxwill be the start page (right-click on index.aspx and select Set as Start
Page).

8 Run the web site.

9 In the Framework Configuration Editor, define the connection parameters as follows:

1. Click on the Framework Configuration link. The Configuration Editor will be displayed.

2. In the Session node, enter the application name. By default, the application name is "In-
stantDemo". In the Session node, it is possible to edit and configure additional connection
and project properties.

3. Click Save to save your changes.

4. Click Close to return to the web application.

Creating an ApplinX .NET Web Application using Visual Studio 2010

To create a new ApplinX web application using Visual Studio 2010

1 Install J# 2.0 redistributable package.

2 Install .NET Framework 3.5 SP1.

3 Install Microsoft Visual Studio 2010 on your computer (install Visual Studio before installing
ApplinX so that when installing ApplinX, the ApplinX web application templates will be
added to the available Visual Studio NewWeb Sites).
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4 Open Visual Studio 2010.

5 In the Filemenu, selectNew and thenWeb Site… to create a new web site. TheNewWeb
Site dialog box is displayed.

6 Select to work either with .NET Framework 2.0 or 4.0.

7 Select the relevant ApplinX web application type (Visual C# or Visual Basic).

8 Define that index.aspxwill be the start page (right-click on index.aspx and select Set as Start
Page).

9 Run the web site

10 In the Framework Configuration Editor, define the connection parameters as follows:

1. Click on the Framework Configuration link. The Configuration Editor will be displayed.

2. In the Session node, enter the application name. By default, the application name is "In-
stantDemo". In the Session node, it is possible to edit and configure additional connection
and project properties.

3. Click Save to save your changes.

4. Click Close to return to the web application.

Creating an ApplinX .NET Web Application using .NET (no IDE)

Note: This is not available when working with a SOA license.

To create a new ASP.NET application without Visual Studio .NET with .NET SDK

1 DuringApplinX installation, select theApplinXASP.NETWebFrameworkC#/VB .NEToption.

2 In the ApplinX Explorer, right-click on the relevant application and selectWeb Application
Manager…. TheWeb Application Managerwizard is displayed.
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3 Ensure that Create a newWeb application (for IIS or Tomcat) is selected. ClickNext. The
Create a NewWeb Application screen is displayed.
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4 Ensure thatC# 2.0 orVB 2.0 is selected. Select the application type:New application to create
a basic ApplinX web application with a web look and feel or Emulation template to create
an ApplinX web application with a host look and feel.

Note: If you wish to create a new web application based on .NET 4.0, you need to use
Visual Studio 2010 (refer to Creating an ApplinX .NET Web Application using Visual
Studio 2010).

5 ClickNext. The Select Template screen is displayed.
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Select a template from the list on the left. ClickNext.

6 The Create a New .NET Web Application screen is displayed.
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7 Enter a name for the web application. By default, this is the name of the ApplinX application
that you selected. Browse and select the destination folder.

8 ClickNext. TheWizard Summary screen is displayed.

9 Select whether to launch the browser when the process is completed.

10 Click Finish. Amessagewill be displayed indicatingwhether the process succeeded or failed.

Note: When using the Application Manager on IIS 7.5 or 8.0, you need to convert your
application from a virtual directory to aweb application (in the IISmanager, right-click
on your application and select Convert to Application).
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Upgrading an ApplinX .NETWeb Application from Visual Studio 2003 to 2005

To upgrade a project from Visual Studio 2003 to Visual Studio 2005

1 In Visual Studio 2005, open the web application by clicking File > Open > WebSite... and se-
lecting the web application.

2 The Visual Studio Conversion Wizard is displayed. ClickNext.

3 Determine whether you would like to create a backup before converting.

4 Click Finish.

5 The conversion process is run. Once completed, errors are displayed in the conversion log.
When necessary, make the required changes to correct these errors (error lines relating to the
project file do not need to be dealt with, as from this point, you are working with a web site
and not a web project). For example, an error "Unable to move file" should be corrected by
manually moving the file.

6 Build theweb site. If errors are displayed, checkwhat these errors are andmake the necessary
changes.

7 Close the web site (File > Close > Solution).

8 In ApplinX Designer, upgrade your web application using the ApplinX Web Application
Manager (refer to Upgrading a .NET Web Application inWeb Application Development.

9 Reopen the web application in Visual Studio 2005 (File > Open > WebSite... and select the
web application).

10 Build the web site. Correct errors.

11 Define that index.aspxwill be the start page (right-click on index.aspx and select Set as Start
Page).

12 You can run the web site to ensure that it performs as expected.

Upgrading an ApplinX .NETWeb Application from Visual Studio 2003 to 2008

To upgrade a project from Visual Studio 2003 to Visual Studio 2008

Ensure that you have J# 2.0 redistributable package installed.

1 In Visual Studio 2008, open the web application by clicking File > Open > WebSite... and se-
lecting the web application.

2 The Visual Studio Conversion Wizard is displayed. ClickNext.
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3 Determine whether you would like to create a backup before converting. ClickNext.

4 Determine whether you would like to work with .NET 2.0 or .NET 3.5.

5 Click Finish.

6 The conversion process is run. Once completed, errors are displayed in the conversion log.
When necessary, make the required changes to correct these errors (error lines relating to the
project file do not need to be dealt with, as from this point, you are working with a web site
and not a web project). For example, an error "Unable to move file" should be corrected by
manually moving the file.

7 Build theweb site. If errors are displayed, checkwhat these errors are andmake the necessary
changes.

8 Close the web site (File > Close > Solution).

9 In ApplinX Designer, upgrade your web application using the ApplinX Web Application
Manager (refer to Upgrading a .NET Web Application inWeb Application Development.

10 Reopen the web application in Visual Studio 2008 (File > Open > WebSite... and select the
web application).

11 Build the web site. Correct errors.

12 Define that index.aspxwill be the start page (right-click on index.aspx and select Set as Start
Page).

13 You can run the web site to ensure that it performs as expected.

Upgrading an ApplinX .NET Web Application to Visual Studio 2010

To upgrade a project to Visual Studio 2010

Ensure that you have J# 2.0 redistributable package Second edition installed.

1 When upgrading to Visual Studio 2010 from Visual Studio 2003, you need to first perform
the upgrade task above: either Upgrading an ApplinX Web Application from Visual Studio
2003 to 2005 or Upgrading an ApplinX Web Application from Visual Studio 2003 to 2008.

2 In Visual Studio 2010, open the web application by clicking File > Open > WebSite... and se-
lecting the web application.

3 Determine whether you would like to work with .NET 2.0 or .NET 4.0.

4 In ApplinX Designer, upgrade your web application using the ApplinX Web Application
Manager (refer to Upgrading a .NET Web Application inWeb Application Development.

5 Define that index.aspxwill be the start page (right-click on index.aspx and select Set as Start
Page).

6 You can run the web site to ensure that it performs as expected.
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ApplinX provides several demo applications: Instant demo, Composite demo and SOA demo,
based on a typical legacyNaturalmainframe application. These applications contain typical legacy
screens such as update screens, task screens, windows screens and more. The web applications of
the demos contain various examples of common tasks needed to be performed in a typical web
enabling/SOA application (in .NET or JSP). Such examples include external login page, path pro-
cedures, and tables combining a few screens to one.

Note: Whenworking inWindowsOS, by default the repository is loaded from the database
providedwith ApplinX.Whenworking with UNIX, the repository of the demo application
is loaded from an external gxz file and therefore changes cannot be made to entities (read-
only).

The Insurance applications (Instant, Composite and SOA)manage customer details and proposals
of a fictitious insurance company. They store and display information about the current customers
and their proposal details. The applications containmodules for updating, deleting, and displaying
customer records and proposals. There are three Insurance based applications:

■ The Instant demo application includes the entities required for an instant web application.
■ The Composite demo application includes, in addition to the entities included in the instant
demo, paths and procedures used in the composite web application.

■ The Service Oriented Architecture (SOA) demo application includes the entities required to
expose Procedure Clients and forms that have been generated.

The ApplinX web demo applications are distributed as part of the ApplinX installation. They
containmany useful examples and code snippets, and therefore it is recommended to install them,
browse through them and inspect their sources.

Installing the Demo Web Application using the Software AG Designer

Refer to Creating an ApplinX Web Application using the Software AG Designer and select the
desired application type.

Installing the Demo Web Application using Tomcat

To install the demo web application

1 Right-click on the relevant application (make sure that it is one of the demo applications: In-
stant, Composite or SOA) and selectWeb Application Manager....

2 Ensure that Create a newWeb application is selected. ClickNext. The Create a NewWeb
Application screen is displayed.
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3 Ensure that JSP is selected as the language.

4 Select the relevant demo name as the Application type. ClickNext.

5 Enter a name for the web application.

6 Browse and select the folder where Tomcat is installed.

7 Select the location of the JDK folder.

8 ClickNext. TheWizard Summary screen is displayed.

9 Select whether to launch the browser when the process is completed.

10 Select whether to restart Tomcat.

11 Click Finish. Amessagewill be displayed indicatingwhether the process succeeded or failed.

Installing the Demo Web Application (Other Java Application Servers)

To install the demo web application

1 Right-click on the relevant application (make sure that it is one of the demo applications: In-
stant, Composite or SOA) and selectDeployment Manager for J2EE....

2 SelectApplinXWeb application for JSP and clickNext. TheSelect ApplinXWebApplication
screen is displayed.

3 Select Project in other location. Browse and select <ApplinX installation>\ApplinX\new
jsp\<demo application name>.

4 Select Include source files to include the Java files as well as the compiled classes. ClickNext.
The Select Package Parameters screen is displayed.

5 Select the Java Application Server, the WAR file name and the destination folder where the
output file will be placed.

6 ClickNext. The Select Target ApplinX Server screen is displayed.

7 Select the name/IP address of the server, the port number and the ApplinX application name.
Click Finish.

8 In the console area, it is possible to see whether the process succeeded or failed. The WAR
file created should be placed in your web server directory.

75Getting Started

Installing ApplinX Demo Applications



Installing the Demo Web Application using Visual Studio

To install the sample application in Visual Studio

1 Open Visual Studio and open a NewWeb Site.

2 In theNewWeb Site dialog box make sure Visual C# is the selected language.

3 Choose one of the following templates:

■ ApplinX C# Composite Demo Application.
■ ApplinX C# Instant Demo Application.
■ ApplinX C# SOA Demo Application.

4 Right-click index.aspx and select Set as Start Page.

5 Click Start to run the project.
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The Instant Demo

■ template.jsp/template.master
■ Screen Name: Login
■ Screen Name: InsuranceMenu
■ Screen Name: BrowseCustomers

Note: When using a replay file, it is possible to navigate from one screen to the next by
pressing ENTER in each web screen. Clicking on buttons which execute paths will work only
if the replay file contains the relevant path navigation recorded and the session screen is in
the relevant starting point to execute the path. If this is not the case, the path will fail and
the user will receive an error from the web application.

When using transformations it is important to notice the order inwhich the transformations appear
in the screen editor (Transformations tab). Transformations can change thewayApplinX perceives
a host screen. If, for example, the first transformation hides a certain text on the screen and the
second transformation searches for that text pattern in order to replace it with a link then the
second transformation will never find a match for that pattern since it has been removed by the
first transformation. So always keep in mind, the order of the transformations in the screen editor
will be the order in which they will be executed.

template.jsp/template.master

Refer to Customizing the Default Template in theWeb Application Development documentation for a
detailed explanation on how to change the default template.

■ The host keys relevant for this screen are displayed on the left of the screen. This is defined in
the template.jsp/template.master (.NETweb apps) file in the host key control. The host key control
displays all the host keys for the current host screen. It is possible to definewhether they should
appear horizontally or vertically , in the form of buttons, links or a pre-defined template (see
"gx:GXHostKeysControl" in .NETweb apps or "gx:hostKeys" tag in JSP applications). The default
host key style is defined in the css/styles_instant.css style sheet in the "gx_hky" class.

■ The Page footer section contains links that performvarious actions such as logging off, refreshing
the page, submitting a terminal key and so on. These links can be defined in the template.jsp/tem-
plate.master file (look for "pgfooter" control in the instant demo app).
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Screen Name: Login

Host Screen
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Screen in Web Application

Note: The sections that are referred to below can be found in the Designing and Developing
an Application documentation.

■ Identify the screen using the "-DEMOCO-" and "COM-PLETE System Logon" texts. Refer to
Define Identifiers.

■ Map theMessage, UserID, Password and Reconnect fields. Refer toMap Fields.
■ The "HideTextTODel" transformation hides text in a defined area. Refer to Transforming a Text
Pattern to Text and select the "Hide" option.

■ The "RemoveDots" transformation removes dots followed by a colon ("...:"). Refer to Transforming
a Text Pattern to Text.

■ The "HideInputField" transformation hides input fields in a defined area. Refer to Transforming
an Input Field to a Text Field and select the "Hide" option.

■ The "HideText" transformation hides text in different areas in the screen. Refer to Transforming
a Text Pattern to Text and select the "Hide" option.
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■ The "DashesToLine" transformation changes all the dashes in the screen to lines. Refer to
Transforming a Repeating Characters Pattern to a Line.

■ The "AddLoginButton" transformation adds a button used to login. Clicking on this button ex-
ecutes the "login" path procedure. Refer to Transforming a Text Pattern to a Button.

The "login" path procedure receives the user ID and password as inputs.
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Screen Name: InsuranceMenu

Host Screen
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Screen in Web Application

Note: The sections that are referred to below can be found in the Designing and Developing
an Application documentation.

■ Identify the screen using the "DEMO" and "DEMOM" texts. Refer to Define Identifiers.
■ Map the Code, Time andMessage fields. Refer toMap Fields.
■ The "CleanMenuScreen" transformation hides text in a number of defined areas in the screen.
Refer to Transforming a Text Pattern to Text and select the "Hide" option.

■ The "AllGroup" screen group includes all the screens that include in row 1, column 23 the content
"*****Demo Insurance Solution*****". The "AllGroup" screen group includes various transform-
ations:
■ Removing the first line in the screen (the "RemoveFirstLine" transformation). Refer to Trans-
forming a Text Pattern to Text and select the "Hide" option.

■ Formatting the screen name (the "FormatScreenNameHeader" transformation).
■ Removing dots that are followed by a colon "...:" (the "RemoveDots" transformation). Refer
to Transforming a Text Pattern to Text.

■ Hiding the time that appears in the top right corner (the "HideText" transformation). Refer
to Transforming a Text Pattern to Text and select the "Hide" option.

■ The "MenusGroup" screen group includes all screens that include text: "code", and text "menu".
This screen group includes a transformationwhich transformsmenus to links (the "MenuToLinks"
transformation). Refer to Transforming a Menu to Hyperlinks.
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■ Associate the "AllGroup" and "MenusGroup" screen groups to this screen.
■ Refer to the template section above to see how to implement placing the host keys on the left of
the screen, and placing buttons in the footer.
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Screen Name: BrowseCustomers

Host Screen
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Screen in Web Application

■ Identify the screen using the "BCUSTBN0" and "BCUSTBN1" texts. Refer to Define Identifiers in
the Designing and Developing an Application documentation.

■ Refer to the Fields tab to see the mapped fields.
■ Refer to the template section above to see how to implement placing the host keys on the left of
the screen, and placing buttons in the footer.

The Composite Demo

■ template.jsp/template.master
■ Screen Name: Login
■ Screen Name: Browse Proposals
■ Screen Name: ModifyProposal1
■ Screen Name: BrowseCustomers1

Note: When using a replay file, it is possible to navigate from one screen to the next by
pressing ENTER in each web screen. Clicking on buttons which execute paths will work only
if the replay file contains the relevant path navigation recorded and the session screen is in
the relevant starting point to execute the path. If this is not the case, the path will fail and
the user will receive an error from the web application.
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template.jsp/template.master

Refer to Customizing the Default Template in theWeb Application Development documentation for a
detailed explanation on how to change the default template.

JSP

In this template we use these panels (that can be overridden by specific pages):

■ CssPanel: holds the css links (has a default in the template).
■ JSPanel: holds the JavaScript code and JavaScript file references.
■ HeaderImagePanel: by design, an image in the top-right corner changes according to the data.
■ MenuPanel: holds the menu that is included in the pages. In some specific pages it is empty,
therefore the menu is not displayed.

■ GXPagePlaceHolder: holds the data for the page.

.NET

In this template we use these panels (that can be overridden by specific pages):

■ CssPanel: holds the css links (has a default in the template).
■ JSPanel: holds the JavaScript code and JavaScript file references.
■ HeaderImagePanel: by design, an image in the top-right corner changes according to the data.
■ MenuPanel: holds the menu that is included in the pages. In some specific pages it is empty,
therefore the menu is not displayed.

■ GXPagePlaceHolder: holds the data for the page.
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Screen Name: Login

Tasks

Refer to the following sections in theWeb Application Development documentation:

■ Building an External Login Page
■ Controlling the Connection Properties from Code
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Screen Name: Browse Proposals

Tasks

Refer to the following sections in theWeb Application Development documentation:

■ Activating an Application Map from a Menu
■ Creating Designed Web Pages
■ Creating a Button / Hyperlink for Submitting a Host Key
■ Using Web Application Controls in Generated Pages
■ Exporting Data to an MS Office Application (Excel, Word)
■ Adding the Sorting Capability to a Screen-Based Table
■ Creating a Page with a Table

89Getting Started

Working with the Demo Applications



Screen Name: ModifyProposal1

Tasks

Refer to the following sections in theWeb Application Development documentation:

■ Collecting Data from Multiple Host Screens
■ Creating a Button / Hyperlink for Executing a Path Procedure
■ Updating Data in Multiple Host Screens
■ Activating an Application Map from a Menu
■ Creating Designed Web Pages
■ Creating a Button / Hyperlink for Submitting a Host Key
■ Using Web Application Controls in Generated Pages
■ Map Fields (identify dynamic fields by their leading label)
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Screen Name: BrowseCustomers1

Tasks

Refer to the following sections in theWeb Application Development documentation:

■ Activating an Application Map from a Menu
■ Creating Designed Web Pages
■ Collecting Data from Multiple Host Screens
■ Creating a Button / Hyperlink for Submitting a Host Key
■ Using Web Application Controls in Generated Pages
■ Adding the Sorting Capability to a Screen-Based Table
■ Exporting Data to an MS Office Application (Excel, Word)
■ Customizing the Table's Display
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The SOA Demo

.NET and JSP implementation can be done in many ways. This demo includes examples of one
way to implement the tasks. For example, in one of the tasks below,we demonstrate how to display
data collected by the procedure client. To do this we use the framework. In .NET, this can also be
implemented using .NET datagrid.

The following lists the different typical tasks that we have demonstrated in the SOA application
included with the ApplinX installation. Next to each task, the entities involved with this task are
detailed. This enables you to further explore the configuration of each of these entities.

1. Identify and define host screens in the ApplinX repository. Refer to Screens in theDesigning and
Developing an Application documentation.
■ INS_Browse_Customers
■ INS_Customer_Details_1
■ INS_Customer_Details_2
■ INS_Customer_Details_3
■ DEMOCO_Login
■ DEMOCO_Menu
■ DEMOCO_Splash
■ E_Environment
■ INS_Menu

2. Create a connection pool with a connection information set (for offline use). Refer to Connection
Pools andConnection Information Sets in theDesigning andDeveloping anApplicationdocumentation.

a. Set the pool size as required.

b. Set a connection information setwhen required (SOADemo includes connection information
sets that allow the application to run in offline mode).

c. Set navigation rules:

i. Create an initialization path for the pool that initializes each new connection in the pool.
This path should finish in the "Initial screen", otherwise the initialization will fail.

ii. Set the initial screen a connection should wait on.

iii. Create and set a recycle path to recycle connections in the pool.

iv. Create and set a termination path for properly terminating a connection in the pool.

As you may have noticed, the SOADemo repository contains three connection pools. This is
for the sole reason of enabling the application to retrieve results in offline environments (that
do not have connectivity to Software AG's network). All three pools share the same setting
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(pool size and navigation settings), but differ in their connection information sets. To enable
offline execution of the application, each procedure has been executed with its own replay file
(set in its connection information set), whereas, online execution requires no replay file at all.

3. Collect data frommultiple screens. Refer to Collecting Data fromMultiple Host Screens in theWeb
Application Development documentation.

a. Create a path procedure which collects table data (refer to the Browse_All_Customers path
procedure). Refer to Creating a Path Procedure in the Designing and Developing an Application
documentation.

i. Assign a connection pool to start from the relevant screen.

ii. Create aWhile loop that checks if an "End of data"message appears on the screen,marking
the table's end.

iii. For every table instance: Collect the tabular host screen data and page down for the next
instance.

b. Create a path procedure which collect data frommultiple screens (refer to the GetCustomer-
ByID path procedure). Refer to Creating a Path Procedure in the Designing and Developing an
Application documentation.

i. Assign a connection pool to start from the relevant screen.

ii. Add an input to allow the user to specify which customer details they wish to retrieve.

iii. Navigate to the Details screens and map host fields to the procedures' output.

c. Assign procedures to procedure groups. Refer to Assigning a Procedure to a Procedure Group
in the Designing and Developing an Application documentation.

d. Generate a procedure client from the procedure group (refer to DemoINS procedure group
in the demo repository). Refer toProcedure Clients in theDesigning andDeveloping anApplication
documentation.

4. Bind web controls to procedure response (output). Refer to Binding Procedure Outputs to an Ap-
plinX Framework Based Web Page in the Designing and Developing an Application documentation.

a. For each procedure, create a JSP/ASPXpagewith controlswhichmatch the procedure output.

b. Fill the form (using gx_fillForm).
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14 Self-Training and Movies

A self-training, basic tutorial of ApplinX and accompanyingmovies can be found on the Software
AG Empower website at https://empower.softwareag.com. After entering your user name and
password, navigate toKnowledgeCenter > ProductDocumentation >webMethods Product Line
> ApplinX > Self-Training.
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